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CHAPTER 1 

INTRODUCTION 

This manual is the user documentation for the DPWH Road Mapping System (RMS). The RMS is a computer program and associated data files which enable maps and data tables of the Philippine road network to be easily produced and output. 

At the most basic level, the RMS can be used to prepare standard road maps of a province. Such a map typically has lines indicating the alignments of the roads in the province's network, and also shows all or some of a province's population centers with appropriate symbols. With RMS a user can choose the class or classes of the network (national, provincial, barangay or other) and the administrative levels of the population centers (barangays, municipalities, chartered cities, provincial capitals) to be shown. Maps can be prepared of a single province or of groups of provinces. 

The RMS can also be used to present information about road characteristics (pavement width or pavement type, for example) by drawing a road map using line types or colors which vary according to the roads' characteristics. For example, a user could prepare a map of road widths with lines whose thickness was related to the width of a road, or a map of pavement type with lines whose color was related to the type. The map legend would explain the correspondence between the line properties (type or color) and the road features. Maps which display information in addition to basic geographic data such as road alignments are called thematic maps. The user can choose to present various road characteristics in a standardized fashion defined by the RMS, or can define a customized thematic presentation of the data to suit his own needs or purposes. 

Although the RMS is primarily a mapping system, it can also prepare tables and reports of road data which can then be printed out or transferred to other systems. 

RMS runs as part of MapInfo for Windows, which is a general-purpose mapping program. It inherits many features from both Microsoft Windows and Mapinfo for Windows. In addition, RMS provides MapInfoI with capabilities specifically tailored to preparing standard and thematic maps and tables of road data. While it is not necessary to know all of Windows' or MapInfo's features and commands before using the RMS, familiarity with Windows and MapInfo can only enhance a user's productivity with the RMS. This document provides a brief introduction to the two systems, but of course the best way of becoming familiar with it is through the various Windows and MapInfo tutorials, guides and manuals. Both systems require familiarity with a minimum number of basic concepts; once these are understood, they are easy to learn and use. 

I Although there are several versions of MapInfo, every reference to Maplnfo in this document should be understood as implying MapInfo for Windows. 
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This user documentation describes how an end user can use the RMS to carry out mapping, 
data display and analysis work. The system is designed to be usable by persons without 
extensive computer experience. In addition to thoroughly describing the RMS system 
capabilities themselves, this manual attempts to clarify general points which might confuse 
a relatively novice computer user encountering MapInfo or Windows for the first time. 

The remainder of the document is organized as follows: 

2 

• Chapter 2 is a general overview of RMS concepts. It explains the way in 
which road maps and data are stored and manipulated in the RMS and 
establishes the vocabulary and ideas used in the remainder of the 
documentation; 

• 

• 

Chapter 3 is a brief introduction to those features of Windows and MapInfo 
which are most useful in the RMS. As stated above, this introduction is not 
intended as a substitute for the Windows or MapInfo documentation itself; 

most user interaction with the RMS is through a series of menus which 
provide the means of indicating what is to be done. Each of the remaining 
chapters is devoted to one of the RMS menus. Each chapter explains what the 
corresponding menu is used for and how to select the various options and 
capabilities which each menu provides. 
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CHAPTER 2 

RMS SYSTEM CONCEPTS 

2.1 TYPES OF DATA A V AILABLE IN THE RMS 

The DPWH RMS contains the following data for each province of the Philippines: 

• provincial boundaries; 

• population centers; these include the provincial capital or capital city, 
chartered cities, municipalities and barangays. Barangays and municipalities 
are located on maps in terms of their poblacion (seat of government or 
administration). Some barangays and a few municipalities may be missing if 
it was not possible to locate them from original map sources, because of place 
name changes for example. The RMS stores the following information about 
each popUlation center: 

• its name according to official National Statistical Office (NSO) lists; 

• its official NSO identification code; 

• a code indicating the administrative type of the population center as 
follows: 

1 
2 
3 
4 
5 

provincial capital which is a chartered city; 
provincial capital, but not a chartered city; 
chartered city; 
municipality; 
barangay. 

All of this information is accessible through the RMS. For example, 
information on population center names can be used to label centers on a map, 
and information on NSO codes can be used to relate the population centers to 
corresponding statistical data (population and household data, for example); 

• roads; in general, all rural national, provincial and barangay roads longer than 
approximately one kilometer2 will appear in the RMS. National and 
provincial roads will generally be identified in terms of their DPWH road 

2 The actual minimum length of road in a province depends on the scale of the original 
hardcopy maps which were digitized to obtain the province road maps. The scale of the 
original maps vary from province to province. 
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number and will have stationing information associated with them; barangay 
roads will in general not be identified nor have stationing information. Roads 
in built-up areas will also generally not be shown. Road numbers and 
stationing data can be displayed and also used as a basis for organizing and 
analyzing other data. 

• road feature data; at the present time, information on pavement type and width 
is available from the DPWH for most national roads; data on pavement type 
is available from the DPWH for most provincial roads. This data is 
accessible through the RMS. Other types of data may be added in the future 
by RMS maintenance staff, as road inventory or other road data collection 
activities are carried out. (The RMS can provide a list and description of 
available road feature data stored in the system.) Road feature data can be 
used for thematic mapping, can be printed out, or can be combined with other 
data for analysis, as described in later chapters. 

End users would not normally be concerned with details of where or how the above data is 
stored in the system. The RMS facilitates controlled access to the above data and provides 
capabilities for examining, reporting and analyzing it. Similarly, end users would not add 
new or updated road or feature data to the system; this task is the responsibility of the RMS 
maintenance staff. 

All geographic data (e.g., provincial boundaries, popUlation centers and roads) are referenced 
to Zone 51 of the Universal Transverse Mercator (UTM) projection. In other words, the 
coordinates of any location in the system are that location's UTM Zone 51 easting and 
northing; these coordinates can be displayed by setting the appropriate RMS options. 

2.2 ADDITIONAL DETAILS ON ROAD AND ROAD FEATURE DATA 

In RMS terminology, road data refers to information on road alignments and identification. 
In the RMS a road is identified by the province in which it is located and by a DPWH 
identification code. The province is designated by a two-digit code assigned by the National 
Statistical Office. Road identification codes are those used internally by the DPWH; on 
National roads these are often the (basically numeric) codes assigned by the 1983 Road 
Inventory System effort and used, with some modifications and extensions, since then. 
Provincial and other roads have been assigned codes in sequential numerical order based on 
the road names. 

Within the RMS, a road is represented as a number of individual segments. A segment has 
information about its province and road identifier, and about the stationing of its two 
endpoints. Segment endpoints are typically intersections of the road with other roads, with 
the provincial boundary, or are the actual beginning or ending points of the road. A location 
along a road is indicated by providing the province/road identification codes and the 
stationing of the location; the RMS interpolates between fixed locations along the road having 
known stationing (these are called control points) to determine the geographic location 
corresponding to the provided stationing. 
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Road feature data, on the other hand, provides information about road characteristics. In RMS terminology, a road feature refers to a particular aspect of a road, of the roadside, of the road environment or of road users that can be described by one or more feature attributes. Road cross-section characteristics, for example, might be a road feature described by attributes such as pavement width, shoulder width, right of way, and so on. Each feature is essentially independent of all other features. 

Road feature data is stored in the RMS by indicating the province code, road identifier, and 
beginning and ending stationings of a section of road having constant attributes for one particular road feature, together with the values of the feature attributes for the section. Such a stretch of road is called a homogeneous section for the feature. The following hypothetical example illustrates the organization of road feature data in the RMS. It shows two different road features, lanes and traffic. The lanes feature consists of a single attribute, the number of lanes; the traffic feature consists of two attributes, AADT (annual average daily traffic) 
and the truck percentage. 

Feature: Lanes 

I Province I Road I Beginning I End II # Lanes I 
10 0001 KP 0 KP 10 EEl 10 0001 KP 10 KP 20 

Feature: Traffic 

I Province I Road I Beginning I End II AADT I % Trucks I 
10 0001 KP ° KP 5 10,000 20 

10 0001 KP 5 KP 15 20,000 15 

10 0001 KP 15 KP 20 20,000 10 

The example shows a single 20 kilometer-long road having the identifier 0001 and located in province 10. With respect to the lanes feature, the road consists of two homogeneous sections, one from kilometer point (KP) 0 to 10 with two lanes, and the other from KP 10 to 20 with four lanes. With respect to the traffic feature, the road consists of three homogeneous sections, as shown in the table. Note that although the AADT is constant between KP 5 and KP 20, there is a change in the truck percentage at KP 15 requiring the creation of a new homogeneous section. A homogeneous section must have constant values for all the attributes associated with a feature. 

All the feature data discussed above was linear in nature: the road characteristics extended over a stretch of road having non-zero length. Not all road feature data is linear, however; accident data, signage data, minor structure inventory data are all examples of data which can more appropriately be considered as point-like. The RMS handles point data by simply requiring that such data have the same beginning and ending kilometer point stationings. The key RMS operations described below (feature merging and dynamic segmentation) work 
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correctly whether linear or point-like data is involved. However, all attributes of a feature 
must be either linear or point-like; a single feature cannot include both types of attributes. 

2.3 FEATURE MERGING 

Although road features are essentially independent of each other, at times it is useful to be 
able to combine two or more different features into a single new feature which pulls together 
the data about each individual feature. To pursue the above example, it may be of interest 
to combine information on number of lanes and traffic into a single new feature so that width 
and traffic information could be analyzed together. The process of combining two or more 
independent features into a new feature is called feature merging; it involves two related 
operations: 

• first, the homogeneous sections of the individual features have to be broken 
down into sections which are homogeneous with respect to all attributes; the 
new sections would typically be shorter in length than the sections in any of 
the individual features; 

• next, the attribute values of the individual features have to be copied over to 
the output feature sections. 

The following table illustrates the result of merging the lanes and traffic features discussed 
above. 

Feature: Lanes x Traffic 

I Province I Road I Beginning I End 
1/ 

# Lanes I AADT I % Trucks I 
10 0001 KP 0 KP 5 2 10,000 20 

10 0001 KP 5 KP 10 2 20,000 15 

10 0001 KP 10 KP 15 4 20,000 15 

10 0001 KP 15 KP 20 4 20,000 10 

The RMS has the ability to do feature merging on any combination of features known to the 
system. The result of the feature merging operation is itself a feature which can be used like 
any other feature in the RMS; it is called a synthetic feature to indicate that it was created 
from data about other features. A synthetic feature can be thematically mapped, printed out 
in tabular form and analyzed using any of the RMS tools provided for these purposes. 
However, the merged feature data is not permanently stored. Once the RMS is exited, the 
merged feature data is lost. To work with the combined data again in another RMS session, 
the feature merging operation would have to be repeated. 

As stated above, feature merging can be carried out using features which are either linear or 
point-like. In the synthetic feature, the attributes for the point-like feature(s) will have values 
equal to 0 at locations where the point-like feature is not present. 
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2.4 DYNAMIC SEGMENTATION 

As was stated above, the RMS represents a road as a sequence of individual segments, where 
segment endpoints are generally determined by the road's intersections with other roads or 
with locations such as provincial boundaries. The stationing of each segment's endpoints is 
recorded in the RMS base data files. However, homogeneous section endpoints will not in 
general coincide with segment endpoints; in other words, the beginning and ending 
stationings of homogeneous sections, as recorded in the road feature data, may well be 
located between two road intersections or other segment endpoints. 

In order for road feature data to be thematically mapped, the RMS has to generate a new set 
of road data in which the road segments coincide with homogeneous sections for the selected 
feature data: in general, mapping systems work with entire segments and cannot, for 
example, shade part of a segment. The procedure by which segments are automatically 
generated to correspond to homogeneous sections of feature data is known as dynamic 
segmentation. The new segments can then be drawn with various line types or colors based 
on the underlying attribute data. Without dynamic segmentation it would not be possible 
visualize feature data. 

Dynamic segmentation with point-like feature data results in the creation of points rather than 
segments in the output. The points have the appropriate attribute data associated with them, 
and MapInfo and the RMS allow points to be thematically shaded, just as segments can be. 

The RMS does not permanently store the new road data which results from a dynamic 
segmentation operation. Each time a user wishes to thematically map road feature data, 
dynamic segmentation must be performed anew. However, the results of dynamic 
segmentation are maintained throughout an RMS session, as long as the selected provinces 
do not change. Thus, a user can perform dynamic segmentation on a number of individual 
features and re-use the results within a session without having to carry out dynamic 
segmentation again. However, changing the province selection causes all earlier dynamic 
segmentation results to be erased. 
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CHAPTER 3 

INTRODUCTION TO MAPINFO FOR WINDOWS 

3.1 INTRODUCTION 

As stated earlier, the DPWH Road Mapping System runs within the mapping program called 
MapInfo for Windows. It enhances MapInfo with capabilities specifically useful in the 
mapping and analysis of road and road feature data. However, many of the operations and 
capabilities of RMS are directly derived from those provided by MapInfo. Thus, it is 
necessary to know something - but not everything - about how to use MapInfo in order 
to be an effective user of the RMS. Similarly, familiarity with some of the basic Windows 
manipulations will facilitate use of MapInfo and the RMS. 

The objective of this chapter is to give a brief overview of the principal aspects of MapInfo 
for Windows that relate to the use of the RMS. It does not attempt to be a substitute for the 
original MapInfo documentation contained in the four documents, Getting Started, User's 
Guide, Reference and Release Notes. Rather, the intent is to provide a "quick start" which 
will get a novice user to the point where he or she can use the RMS to do work. Following 
the "quick start", a user will find it very instructive to turn to the MapInfo documentation 
to more thoroughly learn the capabilities of the system. 

Many of the MapInfo commands are accessed through a series of menus located at the top 
of the computer screen. In the RMS most of the original MapInfo menus have been replaced 
by a new set of menus tailored to the specific requirements of road mapping and data 
analysis. The RMS menus will be discussed in detail in separate chapters below. This 
chapter will focus on more general components of the MapInfo system - starting MapInfo 
and the RMS. 

3.2 STARTING AND ENDING MAPINFO AND THE RMS 

All computer systems on which the RMS has been installed should have been set up in a 
standard way; the setup process involves installation and configuration of Windows, MapInfo 
and the RMS itself. Users should not attempt to modify the configuration of these programs. 

To start MapInfo from the DOS environment, type the following command from the 
keyboard at the DOS prompt3: 

WIN MAPINFOW 

3 All information (text or key presses) to be typed in by the user from the keyboard will 
be shown in this manual using THIS FONT. 
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This command starts up the Windows environment and immediately executes Maplnfo for 
Windows. Once Maplnfo is in control, you can load the RMS using the RUN from the File 
menu. 

To start RMS from the Windows environment, double clic~ with the mouse on the RMS 
icon. This will start up MapInfo for Windows, which will automatically load and begin to 
execute the RMS. 

Selecting the Exit) menu in RMS indicates that the user has finished work. When RMS 
shuts down, it also shuts down MapInfo and leaves the user in the Windows environment. 
An alternative way to leave the RMS and MapInfo is by typing 

ALT-F4 

from the keyboard6
; this also leaves the user in the Windows environment. The easiest way 

to exit Windows is by again typing ALT-F4, which will return to the DOS environment. 

3.3 GENERAL WINDOWS MANIPULATIONS 

Because MapInfo runs within the Microsoft Windows operating environment, most of the 
information which appears on the screen during use of MapInfo or the RMS is organized into 
windows. Windows are objects which can be manipulated in certain predefined ways. 
MapInfo provides particular types of windows such as Mappers and Browsers with specific 
properties; but almost all windows can also be manipulated in certain standard ways: they 
can be opened or closed, moved around the screen, resized and so on. Once a user has 
learned to perform these standard operations on one type of window, the knowledge that has 
been gained can be applied with little or no change to other types of windows. 

This section briefly discusses some of the standard ways of manipulating windows. Many 
books have been written on the subject of Microsoft Windows, which defines most of the 
standard window behaviors. Serious users will want to consult such books to improve their 
knowledge of the system. 

4 To double-click on something means to position the mouse cursor over it and to click 
the left mouse button twice in rapid succession. Double-clicking is a standard way of 
executing a program or loading a data file in Windows. 

5 Menu names will appear in underlined text while menu items (the components of a 
menu which appear when a menu is clicked on) will appear in bold text. A particular menu 
item appearing in a particular menu will sometimes be designated as Menu I Menu Item. 

6 The notation ALT-F4 means to push and hold down the Al t key (which is usually found 
on the lower row of the keyboard) and, while holding it down, to also push the F4 function 
key (located either on the top row of the keyboard, or in a separate group of function keys 
located to the left of the letter and number keys.) Then both keys are released; they don't 
have to be released at the same time. 
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3.3.1 Parts of a Window 

Figure 1 displays a typical window. The following components of the window will be 
discussed in the following sections; readers may want to refer back to this figure to see 
where each of these is located: 

• title bar; 
• window resizing bars/corners; 
• maximize/minimize/restore buttons; 
• control menu box; and 
• scroll bars/box/arrow. 

Control Menu Box 

Horizontfll 
Resizing Bar 

Title Bar 

Figure 1 

Minimize Button 

Horizontfll 
Scroll Bar 

3.3.2 Standard Windows Operations 

Mrucimize 
Button 

Restore 
Button 

Vertical 
Resizing Bar 

Vertic61 
Scroll B6r 

The following paragraphs describe some of the standard windows operations that are likely 
to be of use to RMS users. Emphasis is on use of a mouse to carry out the operations 
because this is generally the most easy-to-learn and natural method. Most of these operations 
can also be carried out through keyboard commands. Reference guides to Microsoft 
Windows explain the keyboard techniques. Serious RMS, Maprnfo and Windows users will 
want to become familiar with both types of method so that the most appropriate and efficient 
operation technique can be used at all times. 

3.3.2.1 Activating a Window 

There may be a number of windows visible on the computer screen. However, only one 
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window can be active at any given time. The active window is indicated by a highlighted 
title bar and is always located "on top of" other windows which it may partially cover. To 
make a particular window active, it suffices to click on any portion of the window that 
appears on the screen. Making the window active may involve a reshuffling and redrawing 
of the various windows on the screen. An hourglass icon will generally appear wile this is 
taking place.7 The previous active window becomes inactive, but no information is lost; it 
is simply put in suspension until activated again. 

3.3.2.2 Moving a Window 

To move a window, drag the window's title bar to the desired pOSItIon. In Windows 
terminology, to drag an object means the following sequence of steps. Point (position) the 
mouse cursor at the object to be dragged. When the mouse cursor is properly positioned, 
push and hold down the left mouse button. While keeping the left mouse button held down, 
move the mouse in the direction which it is desired to move the object; the object's image 
on the screen will also move. When the object is in the desired location on the screen, 
release the left mouse button. The object will remain in the final position. As before, 
portions of the screen may need to be redrawn after an object is dragged to a new location. 
If so, an hourglass icon will appear on the screen while the redraw takes place; the icon will 
revert to the normal cursor shape when the redraw is complete. 

3.3.2.3 Resizing a Window 

It sometimes happens that the default length and width of a partial-screen window are not 
suitable for the work at hand. It is possible to change these using the mouse. Position the 
mouse cursor over the horizontal or vertical resizing bars. (Resizing bars are the central 
portions of a window's horizontal or vertical borders.) When the cursor is in the proper 
position for resizing the window, it will change into a characteristic double arrow. At this 
point, drag the horizontal or vertical bar so that the window assumes the desired dimensions 
(either larger or smaller than the original window.) To resize a window in the vertical and 
horizontal dimensions simultaneously, position the mouse cursor over the appropriate resizing 
corner and drag it to the desired position. (Resizing corners are the non-central portions of 
a window's horizontal or vertical borders. They are marked off by small lines across the 
borders and near the corners.) 

3.3.2.4 Maximizing or Minimizing a Window 

To maximize a window means to draw it so that it occupies the entire computer screen. This 
can be done by clicking with the left mouse button on the maximize button (the button with 
an upward-pointing solid triangle) in the upper right-hand corner of a partial-screen window. 
A maximized window has a restore button (the button with both upward and downward-

7 The hourglass icon is the standard Windows symbol which indicates that some operation 
is underway; it means the user has to wait. 
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pointing solid triangles) in place of the maximize icon. Clicking on the restore button makes 
the window assume the shape and size it had prior to being maximized. 
To minimize a window means to essentially clear it from the screen without completely 
closing it. A minimized window is represented by a small icon, usually at the bottom left 
of the computer screen. This can be done by clicking with the left mouse button on the 
minimize button (the button with a downward-pointing solid triangle), located in the upper 
right-hand corner of a maximized or partial-screen window. The window will disappear 
from the screen and be replaced by a small icon, which is generally located at the bottom of 
the screen but which can be dragged to another location if desired. To restore a minimized 
window to its original (full or partial-screen) shape and size before being minimized, double­
click on the small icon representing it. (To double-click on an object means to point with 
the mouse cursor at the object and to click the left mouse button twice in rapid succession. 
If the two clicks are not made rapidly enough, in general nothing untoward will happen and 
the double-click can be tried again.) 

3.3.2.5 Repositioning within a Window 

Because of its size and shape, a particular window may not be able to show all the 
information that is actually available. For example, a window that shows tabular data may 
only be large enough to display a limited number of rows and columns from the full data 
table. In order to shift the information display so that different information is shown, a set 
of horizontal and vertical scroll bars is provided for most windows. These are located on 
the right and bottom edges of a window. 

Scroll bars can be used in three ways. First, the small square scroll boxes aligned on the 
scroll bar can be dragged along the bar to a desired position. The scroll boxes' position with 
respect to the top and bottom (vertical bar) or the left and right (horizontal bar) ends of the 
scroll bars indicates the corresponding position of the information view with respect to the 
entire set of data. Second, by clicking on the scroll arrows at either end of the scroll bar the 
information view changes in the corresponding direction by one line vertically or a similarly 
small amount horizontally. The scroll box changes position by a corresponding amount. If 
the mouse button is held down on a scroll arrow, the information view shifts continuously. 
Finally, by clicking within a scroll bar on either side of the scroll box, the information view 
changes in the corresponding direction by a screen vertically or some similarly large amount 
horizontally. Again, the scroll box also changes position by a corresponding amount. 

In some cases, if all information is displayed in a screen window and nothing additional 
would be seen by scrolling, the scroll arrows may be absent or grayed out (dimmed) to 
indicate that they cannot be used. 

3.3.2.6 Closing a Window 

To close a windo\lI means to clear it completely from the screen. The information that was 
in the window mayor may not be easily accessible again, depending on the situation. 
Experience will teach when it is preferable to close or to minimize windows. In general, a 
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window should be closed when the user is sure that it will not be necessary to access the data 
again in the short-term; to simply clean up a cluttered screen, it may be advisable to 
minimize, rather than close, windows that are not immediately needed. 

A window can be closed by double-clicking on its control menu box, the small box with a 
horizontal black bar located in the top left-hand corner of most windows. Single-clicking the 
control menu box displays a menu which includes Close as one of its items; this can also be 
used to close the window. 

As a precaution, a Windows program such as MapInfo or the RMS may sometimes ask the 
user certain questions before closing a window. The subject and appropriate response to 
these questions depends on the situation. However, the fact that such questions are being 
asked does not necessarily mean that the window shouldn't be closed; it's usually just a way 
of checking that the user really does want to close the window. 

3.4 MAPPERS 

A mapper is a particular type of window provided by MapInfo to display map data. 

Figure 2 

Any time that Maplnfo is in use and something that looks like a map is on the screen, a 
mapper is involved. A mapper can be manipulated in all the standard ways discussed in 
section 3.3.2 (e.g., maximized, minimized, moved, etc.), but in addition can be manipulated 
in a number of ways which are specific to map-type data. These manipulations can be 
carried out by clicking on the information box at the bottom left of the mapper window, 
which gives access to the Change View dialog box. 

14 Louis Berger International 

818111_ 1_ 



The Change View8 dialog box shows the current zoom level, map scale and center window 
position. The zoom level of a mapper is the distance (in kilometers) from the left side to the 
right side of the displayed area; a high zoom level means that,a wide geographic area is 
being displayed, but that fine details will probably not be clearly seen. The map scale has 
the conventional meaning, but in MapInfo is usually expressed in terms of kilometers per 
centimeter. Multiplying the displayed number by 100,000 will result in a conventional 
expression of the mapper scale. The center window position is the easting (X) and northing 
(Y) of the center of the mapper window, expressed in meters with respect to Zone 51 of the 
UTM projection. If mouse cursor is moved into any of the three boxes displaying this 
information, the cursor takes on a characteristic I-beam shape. By clicking, the selected box 
becomes active and new values can be typed in from the keyboard. The keyboard's 
Backspace key can be used to erase characters to the left of the I-beam cursor and the 
Delete (or Del) key can be used to erase characters to the right of the cursor. Typing a new 
value in one box may also change the value displayed in other boxes. 

Change View 

1m 
When resizing window: -----, 

® [it map to new window 

o p'reserve current scale 

I Cancel I I OK 

Figure 3 

Certain map display options can also be set through the Change View dialog box. By 
clicking on one of the buttons located in the Display in key area of the dialog box, the user 
can choose to have the zoom level, the map scale, or the cursor coordinates (UTM Zone 51 
easting and northing) displayed in the mapper's bottom left annotation area. 

Through the When resizing window dialog box options, the user can also select how map 
redisplay is to be handled when a mapper is resized. The default behavior is to fit the 
original map to the new window: the zoom level remains the same but the map scale 
changes. Alternatively, the user can choose to keep the original scale and to allow the size 
of the new mapper window to determine how much map is shown (by changing the zoom 
level). 

8 Boldface text will be used to refer to dialog boxes as a unit, while italic text will be 
used to refer to specific components of a dialog box. 
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The Change View dialog box is exited by clicking on the OK button if the user wants to 
accept the new mapper values; or by clicking on the Cancel button if the old mapper values 
are to be maintained. After either button has been clicked, the Change View dialog box 
goes away and the mapper window is redisplayed with the appropriate values. 

The Change View dialog box is also accessible through the RMS Map menu discussed in 
Chapter 8 below. The Map menu also allows other types of mapper manipulations to be 
carried out. These are also discussed in Chapter 8. 

3.5 BROWSERS 

A browser is a particular type of window provided by MapInfo to display tabular data. Any 
time MapInfo is in use and something that looks like a spreadsheet (a array of rows and 
columns of data) is on the screen, a browser is involved. A browser can be manipulated in 
all the standard ways discussed in section 3.3.2 (e.g., maximized, minimized, moved, etc.), 
but in addition can be manipulated in a number of ways which are specific to tabular data. 

The rows in a browser window 
correspond to particular objects 
(records) in a database while the 
columns correspond to attributes of the 
objects (fields). The titles (field names) 
of the columns appear at the top of the 
columns beneath the browser title bar. 
Annotation at the bottom left of the 
browser indicates how many records 
are in the browser and which of those 
records are currently in view in the 
window. 

As explained in section 3.3.2.5 above, 
vertical and horizontal scroll bars can 
be used to bring different ranges of 
records and fields, respectively, into 
view. The scroll arrows are grayed out 
if all database records or fields are in 
view. 
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Figure 4 

It is possible to rearrange the order in which the browser columns are displayed. However, 
this is only a temporary change which does not affect the underlying organization of the data. 
To do this, move the mouse cursor over the heading (field name) of a column to be 
repositioned. The mouse cursor will change into the shape of a hand. Drag the column 
heading to the desired location, and release the mouse button when the column appears in 
the desired position. (The data in the browser window will appear grayed out while the 
column order is being rearranged.) 
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It is also possible to change the width of a column in the browser. To do this, move the 
mouse cursor to the vertical line to the right of the heading (field name) of the column to be 
resized. The mouse cursor will change into a four-way arrow. Drag the vertical line left 
or right until the column has the desired width, then release the mouse button. Again, this 
is a temporary change in the browser's appearance which does not affect the underlying 
organization of the data. 

Additional operations on certain RMS browsers are provided in the RMS Tables menu, 
described in Chapter 7 below. 

3.6 LAYOUTS 

A layout is a window which is used for formatting maps or tables for output to a printer or 
plotter. It is never obligatory to use a layout in order to print or plot something. However, 
layouts offer a number of convenient tools for arranging and customizing maps, tables and 
annotations on an output page and so are often used for preparing production-quality output. 

Layouts contain isolated text or graphic objects, as 
well as frames. A frame is a rectangular portion of 
a layout which has been designated to contain the 
image of a mapper or browser also on the screen. 
Maplnfo can automatically create a frame or frames l.::mi®.mmru.mmtE;t$j~ 
when a layout window is opened; the user can also 
define or modify frames. A layout can have any 
number of frames of arbitrary length, width and 
position. 

Most layout manipulations are accessed through the 
RMS Layout menu, which contains a number of 
menu items for carrying out particular tasks. The 
RMS Layout menu, which is briefly described in 
Chapter 9 below, is identical to the Maplnfo Layout 
menu described in the Maplnfo Reference and 
User's Guide. Full details on the use of these 
commands can be obtained from these sources, and 
in fact proficiency with layouts only comes after a 
considerable amount of experimentation and ... ---............... ----........... 
experience. Figure 5 

The layout window itself allows some control by clicking on the information box in the lower 
left-hand corner. This action opens the Layout Display Options dialog box. With this 
dialog box, the user can choose to have the layout contents displayed always, never, or only 
when the layout window is active. The layout normally contains horizontal and vertical 
rulers (graduated in centimeters) that allow the true (printed or plotted) size of objects to be 
judged; these can be turned off or on by clicking on the Show Rulers check box. Normally 
too the layout draws dotted lines to show when requested output exceeds the size of a page 
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(as specified in the RMS Print Setup menu item of the File menu); this feature can also be 
turned off or on by clicking on the Show Page Breaks check box. In fact, however, there 
is normally little reason to change the default settings for these options. 

The final control in the Layout Display Options dialog box specifies the zoom level of the 
layout. Unlike the mapper zoom level discussed in section 3.3.3 above, a layout's zoom 
level refers to the ratio of screen image size to true size and is expressed as a percentage. 
A layout zoom level less than 100% means that the screen image of the layout is smaller than 
it will actually appear on the output, while a zoom level greater than 100%9 means that the 
screen image of the layout is larger than it will actually appear on output. This parameter 
can be directly specified by moving the mouse cursor into the Zoom box and clicking when 
it becomes an I-beam cursor. The desired zoom level can then be directly typed in. 

Any changes specified in the Layout Display Options dialog box can be ignored by clicking 
on the box's Cancel button; they are made effective by clicking on its OK button. In either 
case, the dialog box is removed from the screen and the layout (which was partially covered 
up by the dialog box) is redrawn. 

3.7 THE MAPINFO TOOL PALETTE 

Tools 
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The MapInfo tool palette is a rectangular array of icons which appears on 
the MapInfo screen. (In fact the palette is a special type of window; while 
it cannot be closed or resized by an end user, it can be dragged to a 
different position on the screen if desired.) Each icon in the palette 
represents a particular kind of "tool". By clicking on a particular tool, the 
mouse and/or keyboard can be used to carry out a specific processing task; 
often the shape of the cursor itself also changes, after a tool has been 
selected, to indicate the task which it can be used to perform. At any 
given time, certain tools may be active (selectable) or inactive; for 
example, tools used with mappers would not normally be selectable when 
the active window is a browser. The set of active and inactive tools 
changes automatically with changes in the MapInfo context. Inactive tools 
are dimmed (grayed). 

Each tool in the palette has a name. The following list furnishes a brief description of each 
tool (in left to right, top to bottom order of their appearance in the tool palette); each is 
thoroughly documented in the MapInfo Reference and User's Guide, which should be 
consulted for further details on the purpose and use of these tools. 

9 As will be seen in Chapter 9, percentage zoom values appearing in layout windows 
should be considered as approximate. 
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SelectTool: used to designate one or more objects (mapper or layout) or 
records (browser) for further analysis or editing; double clicking on an 
object with Select Tool displays a dialog box allowing access to some of the 
internal MapInfo object parameters; 

Grabber Tool: dragging a mapper with the Grabber Tool changes the view 
shown in the mapper without changing the scale or zoom level; only the 
location of the center point changes; 

Radius Search Tool: used to automatically select all objects in a mapper that 
are within a circle drawn with the tool; 

Polygon Search Tool: similar to the Radius Search Tool, but used to 
automatically select all objects in a mapper that are located within the 
boundaries of a polygon drawn with the tool; 

Zoom In Tool: dragging on a mapper with the Zoom In Tool draws a 
rectangle on the screen; when the left mouse button is released, the area 
within the rectangle expands to fill the entire mapper window (which itself 
does not change size); this provides a more detailed view of a smaller area 
than was shown in the original window; 

Zoom Out Tool: dragging on a mapper with the Zoom Out Tool draws a 
rectangle on the screen; when the left mouse button is released, the entire 
area shown in the mapper is shrunk to occupy the rectangle; the remainder 
of the mapper window (which does not change size) is drawn with data 
which could not previously be shown because of the scale; this operation 
provides a less detailed view of a larger area than was shown in the original 
window; 

Info Tool: clicking on a mapper object with the Info Tool opens a small Info 
window which displays in tabular format any data associated with the object. 
For example, clicking with the Info Tool on the symbol of a population 
center will open a window showing the population center's name, NSO code 
and type (as discussed in Section 2.1); clicking on a segment of identified 
road will display the province code, road identifier, and beginning and 
ending stationings of the segment. If several objects are on top of each 
other on the screen, clicking successively with the Info Tool while holding 
down the CTRL key will display information windows for each of the objects 
in turn; 

Label Tool: clicking on an object with the Label Tool will cause some 
information about the object to be written on the screen (this text is called 
a label). The Layer Control menu item in the Map menu allows the user 
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to select the information that will be written. Labels can be repositioned by 
using the Select Tool to drag them to a new location on the screen. Labels 
appear on plots and layouts, but are not permanent: they are not preserved 
from one MapInfo/RMS session to the next; 

Text Tool: clicking on a mapper location with the text tool allows the user 
to type in text annotations starting at that location; like labels, text 
annotations are not preserved between RMS sessions but do appear on plots 
or layouts; 

Ruler Tool: the Ruler Tool is used to measure straight-line distances between 
points in a mapper. To use the Ruler Tool, click on the starting point, then 
the next point and so on. Dotted lines between the selected points are 
temporarily drawn on the map. A small window displays the total 
cumulative distance from the starting point through to the last selected point, 
as well as the partial distance from the last point to the current cursor 
position. Distance measurement is terminated by double-clicking; 

Point, Line, Polyline, Region, Ellipse, Arc, Rectangle and Rounded 
Rectangle Tools: these are used to draw the corresponding types of objects 
on a mapper or layout window; 

Frame Tool: the Frame Tool is used to define frames within a layout 
window; 

MapBasic Tool: this tool would not normally be used by RMS end users. 

Some of the tools in the Tool Palette are unlikely to be of much use in the RMS. Probably 
the Select, Grabber, Zoom In, Zoom Out, Info, Label, Text, Ruler and Frame Tools will 
prove the most useful to RMS end users. Again, the MapInfo documentation should be 
consulted for full details on the capabilities and utilization of these tools. 

The remaining chapters of this manual explain the various RMS menus. Each chapter treats 
one of the system's menus, with individual sections on the various menu items it contains. 
There will be little discussion of more general MapInfo capabilities except as specifically 
required for the presentation of the RMS. 
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CHAPTER 4 

THE FILE MENU 

4.1 INTRODUCTION 

The File Menu contains the functions that the user needs in the preparation of Base maps 
for analysis and presentation. 

Print Setup 
Print 

Preferences 

Figure 6 

• menu item Setup Base Map creates the base map that will serve for data 
display and analysis. 

• menu item Setup Features which is used to select and prepare the road 
feature data of interest. 

• menu item Print Setup which is used to select the output device that will be 
used by RMS 

• menu item Print prints a copy of active window 

• menu item Preferences which allows the user to specify the location of files 

• menu item Exit shuts down the RMS and MapInfo 
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4.2 SETUP BASE MAP 

When using the RMS, the first operation that must be performed by the user is the 
preparation of the base map. Preparation of a base map involves: 

• specification of the province or provinces of interest; 

• specification of the roads of interest by indicating the administrative 
classification (national, provincial, barangay, other) of the roads to be 
displayed and analyzed; and 

• specification of the population centers of interest by indicating the 
administrative levels (provincial capitals; chartered cities; municipalities; 
barangays) to be displayed. 

The purpose of this setup operation is not just to prepare and display a map on the computer 
screen, but also to set up internal tables which allow the RMS to carry out other processing 
work which might be requested. Thus, even if the user does not require the actual 
preparation of a base map, the various steps of the Setup Base Map menu item must be 
carried out. The mapper window which is displayed at the conclusion of these setup steps, 
and which shows the base map resulting from the specifications, can always be closed if 
desired. 

Clicking the menu item Setup Base Map a dialog box is displayed. 

Setup Base Map 

Province: 

Aurora Subprovince + Population Centers 

Basilan 
Bataan 
Batanes 
Batan as 

rgJ Provincial Capitals 

rgJ Chartered Cities 

: - I -

Biliran 
Bohol 

rgJ i:M:~~:~~:~p:~!J~;:~!; 
D Barangays 

Road Classification ---------, 
o All Roads "--O-K-""" 

@ National and Provincial Roads Only 

o National Roads Only 

o Provincial Roads Only 
Cancel 

Figure 7 

The Dialog box of the Setup Base Map menu item correspond closely to the three required 
operations listed below: 
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• PROVINCES menu allows the specification of the province or provinces of 
interest; 
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• ROAD CLASSIFICATION menu is used to designate the road administrative 
classifications of interest; 

• POPULATION CENTERS menu permits the selection of the administrative 
levels of the population centers to be displayed. 

4.2.1 Selecting Provinces 

A scrollable list box of alphabetically-ordered province names is provided by the system. 
To select a particular (single) province, it suffices to click on it. The province name will 
change color within the list box to indicate that the selection has been made. The list box 
includes a vertical scroll bar which can be used to reposition the list if needed. 

Any number of provinces may in fact be selected. To select several provinces, the keyboard 
CTRL key should be held down while clicking on the desired provinces. Each selected 
province name will change color. To unselect one particular province in a set, click on it 
a second time (while keeping the CTRL key held down); that province will be removed from 
the set but other provinces in the set will not be affected. If a province is clicked on when 
the CTRL key is not held down, the entire selected set will be unselected and will have to 
be selected again if desired. 

4.2.2 Selecting Road Classification 

This choices will allow the user to specify which road classes are of interest for a particular 
RMS session. The following choices will be available through a set of option buttons: 

• all roads(i.e,rural , national, provincial and barangay roads); 
• national and provincial roads only; 
• national roads only; 
• provincial roads only. 

Only one option button can be selected at any given time. The default choice is to display 
all roads, but clicking on any of the option buttons will cause the corresponding choice to 
be selected. 

4.2.3 Selecting Population Centers 

Through the check box menu, the user has the ability to specify which population center are 
to be displayed on the base map by checking the box on or off through clicking. The 
possibilities are as follows: 

• provincial capitals; 
• chartered cities; 
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• municipalities; 
• barangay 

Each administrative level has a standard symbol which is displayed on the base map at the 
location of the government or administrative seat. The Population Centers Check box menu 
determines which of the symbols will actually appear on the base map and be included in the 
RMS internal tables. 

If several provinces were chosen via the Provinces Multi List Box, the population center 
display option applies to all of the provinces. It is not currently possible in the RMS, for 
example, to display all administrative levels in one province and only the capital and cities 
in others. (This behavior will also apply to the selection of road classifications.) 

Once the user has completed the selection of provinces, road classes and administrative levels 
as described above, the OK button should be chosen. This causes the RMS to prepare the 
selected information, to set up a number of internal tables which are needed for further RMS 
processing, and to display the selected information in a full-screen mapper. (If only a 
portion of the selected province(s) is shown in the mapper, the Map I Change View menu 
item or the Zoom Out tool from the Tool Palette can be used to view a larger area.) 

If the selection for a province has been completed, it it possible to select a different 
province. A warning will be issued, click CONTINUE to go ahead or CANCEL to nullify 
the selection. It is also possible to choose a different road classsification or administrative 
levells after a selection has been completed, this is done by selecting a different road class 
or population center/s and omitting any province selection. 

The selection may be cancelled by clicking the CANCEL button; in this situation a reminder 
that the province selection must be carried out is issued. In either case, ,control is returned 
to the File main menu. 

The user must take note that the display of province boundaries and other information in a 
mapper is not actually carried out until the OK button is executed. 

The Title bar of the mapper window will indicate the name of the province if the provinces 
selected is less than three and the text "Provincial Maps" if it is more than three. 

There are four layers(MapInfo Tables) being used by the system. 

• 

• 

• 

• 

24 

SegTab is a table with data on the road segments belonging to roads with the 
selected administrative classes in the selected provinces; 

PopTab is a table containing information about the selected administrative 
levels of population centers in the selected provinces; 

BdyTab is a table which stores data about the provincial boundaries of the 
selected provinces. 

RoadTab is a table which stores data about the identified roads together with 
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the beginning and ending stations .. 

It is useful to know what these tables represent because the Map I Layer Control menu item, 
among others, refers to the tables by name when the user specifies certain map display 
options such as label variables and fonts. 

At this point it is possible to examine the base map on the screen or to plot it out using the 
Print Setup and Print menu items. However, if it is desired to view and analyze road 
feature data, the Setup Features menu, described in the next section, must be executed. 

4.3 SETUP FEATURES 

The Setup Features menu item allow the users to: 

• examine what feature data is available in the RMS and what attributes are 
stored for each feature (see section 2.2 above); 

• select two or more features and merge them into a single synthetic feature (see 
Section 2.3 above); and 

• select a feature and dynamically segment the road network based on its 
homogeneous sections (see section 2.4 above). 

It is only necessary to utilize the Setup Features menu item and its processing options if 
road feature data is to be analyzed and mapped. If base map preparation and output is all 
that is required, the Setup Base Map, Print, Print Setup menu items and Layout (optional) 
menu can be used without using the Setup Features and other menus. However, thematic 
mapping or road feature data analysis require dynamic segmentation be carried out in order 
to prepare the base map and data. Figure 8 displays the Setup Features Dialog box. 

Setup Features 

Pick One or More Features 

Pavement Cross Section Characteristics T. 
""T~~ I •• - -,. I· 

Section Traffic Data 1+ 

OK II Feature Merge II Show Fields II Cancel I 

Figm'e 8 

Feature merging mayor may not be required in a given RMS session, depending on whether 
or not several separate features are of interest. (The only way to simultaneously access data 
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from two or more features is to perform a feature merge.) After feature merging has been 
done, the resulting output feature can only be mapped or analyzed after a dynamic 
segmentation based on the output feature has been done. 

The Setup Features menu item is used to select either a single feature for dynamic 
segmentation or else two or more features for feature merging. Clicking on the menu item 
displays a dialog box with a scrollable list of available features (feature attributes are not 
shown, however) together with an OK, Feature Merge, Show Fields and Cancel button. The 
scrollable list box contains descriptions of each available feature, including any temporary 
synthetic features which may have been created as a result of feature merging. 

To select a single feature (for dynamic segmentation), click on it. The feature description 
in the scrollable list box will change color to show that it has been selected. Then click on 
the OK button to complete the selection and close the dialog box. If the wrong feature is 
clicked on (before clicking on the OK button), it suffices to click on the correct one to shift 
the selection from one to the other; then the OK button can be clicked. Clicking on Cancel 
nullifies any selection which might have been made and closes the dialog box. This is not 
an error, but some feature will have to be selected before proceeding with further work. 

To select two or more features (for feature merging), hold down the CTRL keyboard key 
while clicking on the desired features with the mouse. Each of the clicked on features will 
change color to indicate that it has been selected. While the CTRL key is still being held 
down, a selected feature can be un selected by clicking on it a second time. (Note that the 
technique of multiple selection described here is the same as that described in section 4.2 
under the explanation of the selection of several provinces for processing.) When all desired 
features have been selected, click on the Feature Merge button. to indicate that the selection 
process is complete. As before, clicking on the Cancel button does not result in an error, 
but the Setup Features menu item will have to be executed again before thematic mapping 
or further analysis can be done. 

4.3.1 Feature Merge 

Clicking on the Feature Merge button displays a dialog box which contains a text box 
requesting the user to provide a description for the output synthetic feature file, together with 
OK and Cancel buttons. 

II Output merged feature file 

Description: 

OK I Cancel I 

Figure 9 

The user simply clicks in the text box, then types in a suitable description of the output 
synthetic feature file to be created. Clicking on the OK button will confirm the input and 

26 Louis Berger International 



close the dialog box; clicking on the Cancel button will nullify the input and cause the display of an information message. 

After the OK button is clicked, the screen will flash and redraw, signifying that the feature merging has been performed. Before thematic mapping or analysis tasks can be performed, the user will have to explicitly select the feature of interest for the task: the synthetic feature resulting from the feature is not automatically selected. After the feature merging is complete, a message is displayed to remind the user to select a single feature before proceeding. 

The text description provided by the user will appear in all the feature selection list boxes preceded by a "(T)" to indicate that the feature is temporary and will be erased at the end of the RMS session. 

4.3.2 Show Fields 

The Show Fields button displays a list with description of the road features available in the RMS and an OK and Cancel button. Figure 10 below displays the typical dialog box when the user click on the Show Fields button. 

II Feature Fields 

PCTHV - Percentage of heavy vehicles 
MDT - MDT estimate from latest counts 

Figure 10 

4.3.3 Dynamic Segmentation 

OK 

Processing the data (that is by clicking the OK button from the Setup Features menu item) initiates dynamic segmentation based on the homogeneous sections of a selected feature. One and only one feature must have been selected, prior to selecting the OK button. 

No user interaction is required during this process. Because dynamic segmentation is a computation-intensive task, it may take a few minutes for the procedure to be carried out; the actual time depends on the number of homogeneolls sections in the feature data for the selected roads. An hourglass icon is displayed over the base map while the dynamic segmentation is taking place. If the currently-selected feature has already been used in dynamic segmentation during the RMS session, the earlier results are automatically re-used; 
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in other words, the RMS will not re-segment the network. 

When the dynamic segmentation procedure is finished, the hourglass icon is replaced by a normal mouse cursor, and the mapper title bar indicates a new overlay (layer) called Attributes in addition to the usual layers SegTab, PopTab and BdyTab. The Attributes layer looks the same as the SegTab layer (the two overlap perfectly). However, road segments in the Attribute layer correspond to the feature data homogeneous sections. They follow the alignment of the road, but begin and end at the beginning and ending stationings of homogeneous sections (rather than at intersections and other similar locations, as they do in SegTab). Furthermore, the feature data corresponding to each homogeneous section on the Attribute layer is accessible from the mapper; clicking on an object in the Attribute layer with the Info Tool (in the MapInfo tool palette) will open an Information window which displays not only the usual province code, road identifier, and beginning and ending stationings (of the homogeneous section), but also the feature data for the section. 

As stated earlier, the OK button must be executed after selecting a feature to carry out dynamic segmentation of the selected feature data in order for thematic mapping or other analysis tasks to be carried out. 

4.4 PRINT SETUP 

The Print Setup menu item is used to select the output device that will be used as a basis for preparing a layout, or for outputting RMS map or tabular data. 

It displays a scrollable list of available 
output devices. Clicking on a 
member of the list selects that device 
as the current output device, and 
clicking on the Setup ... button gives 
access to additional parameters which 
can be used to configure the output 
device. The exact set of accessible 
parameters depends closely on the 
selected device; typically, the Setup ... 
button allows specification of such 
things as paper size, manual or 
automatic sheet feed, color choices 
(for color output devices), etc. 

II Printer Setup 

~urrent Printer 
AS T T urbolaser IPS on lPT 1 : 
E pson FX-1050 on LPTl: 
HP LaserJet III on LPTl: 
HP LaserJet Series /I on LPTl: 
HP PaintJet on LPTl: 
HP PaintJet Xl on LPTl: 

Cancel II ~ __ O_K __ ~ 

Figure 11 

After setting up the selected device with the parameters appropriate for the desired output, clicking on the OK button confirms the choice and establishes the parameters for the device; it is not necessary to reselect these parameters the next time the device is chosen, although they can be explicitly changed if desired. 
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II HP PaintJet XL 

Resolution: r.f()fl~-'::;'- ------ --- ------1" 
~ ________ ~ _________ -------1Si1 01( 

Paper Si~e: I letter B U x 11 in 
Cancel 

Paper ~ource: I'--P_a.;,..pe_r_T_ra.....;;y'--________ '--, !:-,' I .Qptions ... 

Orientation -----, 

® fortrait About ... 

o landscape .!:ielp 

Figure 12 

The Windows Setup application can be used to install additional devices for use by Windows 
and the Control Panel application can be used to perform a more detailed system setup for 
output devices. This will ordinarily have been done (or verified) when the RMS was 
installed, and will only have to be modified if new hardware or upgraded software drivers 
are installed. 

Note that although Windows and MapInfo refer to printers in a generic sense, the menu 
options apply equally well to printers and to plotters. Usually the setup menus will clarify 
whether a given device is considered a plotter or a printer. 

4.5 PRINT 

Clicking on the Print menu item prints a copy of the active window to the current output 
device and with the current configuration options. Figure 13 display a standard dialog box 
for printing. 

12 Print Map 

Print to: HP PaintJet Xl on lPT1: OK 

~opies: '=0'--_-' Cancel 

Pages: @ All 0 [rom: D 10: D I Margins ... 

o C~ntered on 'Window Map Contents: @ £ame as Window 

Map Size: 0 ~indow Size @ Full fage 0 Cystom 

Custom 'Wi!!.th: 17.50 I in .!:ieight: 14.13 I in 

Custom Scale: 1 in = 122.70 Ikm 

Figure 13 
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The title of the dialog box which is opened confirms the type of window being output 
(mapper, browser, layout, etc.); the dialog box itself allows specifications of last-minute 
options such as the number of copies to output and the page margins to use. 

4.6 PREFERENCES 

When you choose Preferences from the File Menu , the Preferences Dialog Box appears. 
RMS then lets you set or change directories for the location of files that being used by the 
system(see Figure 14) 

RMS Preferences 

System Directory I~ 

Feature Files Directory I\RMS\FF 

Spatial Files Directory I\RMS\SF 

o Save to C:\MAPINFO\RMS.lNI OK Cancel 

Figure 14 

The files that being used by RMS are grouped into three directories. 

• The SYSTEM DIRECTORY which contains the RMS program files; 

• The FEATURE FILE DIRECTORY which contains the Data Dictionary and 
Road Feature Data Files; 

• The SPATIAL FILE DIRECTORY which contains the Province Boundaries, 
Population Centers and Road Files 

The changes or setting that the user made can be save permanently using the Check Box 
control; the user checks the box on or off by clicking. If the Check Box is on, RMS will 
save the setting on file RMS. INI located in the mapinfo directory. The system will create 
the RMS.INI file if no such file exists. 

Clicking the OK button will make the setting in effect while the Cancel button will the cause 
the previous setting to remain in effect. 
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The user can modify the RMS.INI in two ways 

• using an editor outside RMS 

• using menu item PREFERENCES in RMS 

Since that RMS.INI is the first file needed by the system, menu item Preferences will 
invoked automatically once you run RMS without the RMS.INI. This process is being used 
in order that the user may be able to indicate the location of file that RMS will be using. 

4.7 EXIT 

The Exit menu item shuts down the both the RMS and Maplnfo, leaving the user in the 
Windows environment.. When the RMS is shut down, temporary files are erased and 
permanent files are closed. 
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CHAPTER 5 

THE ANALYSIS MENU 

All of the work in selecting and setting up data for mapping and analysis is carried out with 
the Setup Base Map and Setup Features menu items. Once any required feature merging 
has been performed, and the selected road network has been dynamically segmented in 
accordance with the selected feature's homogeneous sections, then analysis, mapping and data 
output can begin. The remaining menus provide capabilities required for these tasks. 

5.1 INTRODUCTION 

The Analysis menu includes a number of menu items useful for examining and transforming 
available RMS data, and for locating and identifying roads and popUlation centers in the 
selected provinces. 

Figure 15 

The menu items it provides are as follows: 

• menu item Select, which is a direct pass-through to the original MapInfo SQL 
Select menu item; 

• menu item Unselect All, which enables any selected map objects or table 
records to be easily unselected; 

• menu item Find Selection, which positions a mapper to display an object 
selected in a corresponding browser, and vice versa; 
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• menu item Find Road, which displays a list of currently available roads (i.e., 
those that were selected through the province and road classification selection 
menu items); the user can click on one of the displayed roads and it will be 
highlighted on the mapper; 

• menu item Find Population Center, which displays a list of currently 
available population centers (i.e., those that were selected through the 
province and population center selection menu items); the user can click on 
one of the displayed population centers and it will be highlighted on the 
mapper; 

• menu item Statistics, which calculates and displays summary statistics about 
selected items. 

5.2 SELECT 

The MapInfo SQL Select menu item is a very powerful data selection and analysis command. 
It implements major portions of the standard SQL (Structured Query Language) database 
language. 

SOL Select 

s.,." £0'"." I" 
:====================::::::: 

hom lable~: SegTa~ 

~==============~ 
.!'!.here condition: 

group by columns: 

:=================~ 
Qrder by columns: 

:=================~ 
!nto table named: 1-1 S_el_ec_tio_n _______ -----' 

Tables ... 

Columns ... 

Operators ... 

Aggregates ... 

Functions T 

D !!.rowse result. Clear I I ~erily Cancel II OK 

Figure 16 

MapInfo 's SQL capabilities are discussed at length in Chapter 8 of the Maplnfo Use's Guide 
and under the SQL Select command writeup as well as in Appendix 5 in the Mapinfo 
Reference . The SQL Select menu item provided in the RMS is identical to the version 
provided by MapInfo. The RMS user should refer to the MapInfo documentation for further 
information on this powerful data analysis command. 

5.3 UNSELECT ALL 

Clicking on the Unselect All menu item is a rapid way of un selecting any objects or records 
that may be selected; it doesn't matter whether they are visible on the screen or not. This 
menu item is a direct pass-through to the corresponding Maplnfo menu item; Maplnfo 
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documentation may be consulted for additional details. 

5.4 FIND SELECTION 

The Find Selection menu item is another direct pass-through to the MapInfo menu item of 
the same name. This menu item is useful when a mapper and a browser of the same data 
are both present on the screen. 

If the mapper is active and a mapper object is selected, clicking on the Find Selection menu 
item will display the corresponding record in the browser; the record will be highlighted, of 
course, because it corresponds to a selected object. The range of records displayed in the 
browser will be shifted, if required, to bring the selected record into view. If the browser 
is active and a record is selected, clicking on the Find Selection menu item will display the 
corresponding object in the mapper; the object will be highlighted, of course, because it 
corresponds to a selected record. The mapper's center position will be shifted, if needed, 
to bring the object into view, but its zoom level and scale will not be modified. It may 
sometimes be necessary to change these manually (by clicking on the bottom left information 
box of the mapper window or using the Map I Change View menu item) to get a better idea 
of the location of the object being displayed. 

5.5 FIND ROAD 

The Find Road menu item is used to 
highlight a road on the map, given its 
road identifier. Clicking on the menu 
item presents a dialog box in which the 
set of available roads (chosen in terms 
of the selected provinces and 
administrative classification and 
displayed in terms of their province 
code and road identifier) is shown in a 
scrollable list box. Clicking on one of 
the roads in the list box, then on the 
dialog box OK button, highlights the 
corresponding road in the mapper on the 
screen. 

5.6 FIND POPULATION CENTER 

Select Road Number 

Road Number: -+ 

OK I Cancel 

Figure 17 

The Find Population Center menu item is similar to the Find Road menu item except that 
the available population centers (specified in terms of the selected provinces and population 
center administrative levels) is shown. Clicking on one of the population centers displayed 
by name on the screen highlights the corresponding center in the mapper on the screen. 
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Elle ~alysts Iables ,S,tyle Maps Layout Help 

Figure 18 
The displayed list of population centers is actually a browser; when there is no further need 
to make use of the Find Population Center option, the browser should be closed using normal 
Windows techniques (see section 3.3.2.6). 

5.7 STATISTICS 

The Statistics menu item is a direct pass-through to the MapInfo menu item of the same 
name. Clicking on the menu item displays a window showing the sum and average of all 
numeric fields for all currently selected objects. 

Column Statistics 

Table: SegTab 

Column: KPO 
Count: 608 

Minimum: 0 

Maximum: 313.14 

Range: 313.14 

Sum: ,(,(851.63 

Mean: 73.7691 

Variance: 14016.53 

Standard Deviation: 118.391 

OK 

Figure 19 

Selecting other objects will cause the sum and average to be immediately updated as long as 
the window is open. 
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CHAPTER 6 

THE TABLES MENU 

6.1 INTRODUCTION 

The Tables menu gives access to a limited number of MapInfo browser commands for 
working with the Attributes table created by dynamic segmentation (see Chapter 5 above). 

Figure 20 

It contains three menu items: 

• menu item Table opens a browser for the Attributes table; 

• menu item Pick Fields enables a subset of the Attribute table fields to be 
displayed in the browser if desired; 

• menu item Grid turns the browser's row and column grid lines off and on. 

6.2 TABLE 

Following creation of the Attributes table by dynamic segmentation, clicking on the 
Tables I Table menu item will open a partial-screen browser for the Attributes table. (The 
mapper will also be reduced to partial-screen size.). Figure 21 will show you a typical 
Attributes Table 
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304.972 
records 1 . 14 of 66 . ~. 

Figm'e 21 

Operations on browsers are discussed in section 3.5 above. 

6.3 PICK FIELDS 

The Pick Fields menu item is a direct pass-through to the MapInfo menu item of the same 
name. It enables the browser to be customized by allowing users to remove unnecessary 
columns from the Attributes table. (Columns which are accidently removed from the 
browser can also be re-added.) 

The command displays a dialog box with two groups of column names: those in the 
Attributes table and those currently in the browser. Initially, all columns in the Attributes 
table are also in the browser. Clicking on a column name in the Attributes group, then 
clicking on the > > Add> > button adds the column to the browser. Conversely, clicking 
on a column name in the browser group and clicking on the Remove button eliminates the 
corresponding column from the browser. 

Click on the OK button to confirm the changes to the browser, or click on Cancel to revert 
to the browser's original format. 

As discussed in section 3.5, it is also possible to directly change the column width and order 
using the mouse cursor. Neither these changes, nor those made through the Pick Fields 
menu, affect the underlying Attribute table data in any way. They only change the way in 
which this data is displayed in the browser. 
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6.4 HIDE GRID/SHOW GRID 

This menu item hides the rectangular grid lines delineating the browser's rows and columns 
if they are present, and shows them if they are absent. The change takes effect on the 
screen, and also on any output if the browser is printed. 

If the Hide Grid menu item is clicked, the grid disappears and the menu item changes to 
read Show Grid. If the Show Grid menu item is then clicked, the grid reappears and the 
menu item changes to read Hide Grid. 
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CHAPTER 7 

THE MAPS MENU 

7.1 INTRODUCTION 

Most of the operations directly related to the specification and creation of a thematic map, 
and to the adjustment of map characteristics, are carried out using the Maps menu. The 
Maps menu can be used to set or modify some of the presentation features of a standard 
(i.e., non-thematic) road map, as well as to instruct the RMS to create a thematic map based 
on a prior dynamic segmentation operation. 

Change View 
Previous View 
View Entire Layer 

Autolabel 

Figure 22 

The menu items contained in the menu are as follows: 

• menu item Map, which is used to create a mapper window; 

• menu item Layer Control, which is a pass-through to the MapInfo menu item 
of the same name; it allows the specification of the ordering and display 
features of each layer in a mapper; 

• menu item Thematic Map, which creates a thematic map based on one of the 
available feature attributes; either a standard or a user-defined legend can be 
used for the thematic mapping; 

• menu item Remove Thematic Map, which removes the thematic map and the 
standard or user-defined legend on the screen. 
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• menu item Show/Hide Map Grid, which turns the map grids on and off 

• menu item Customize Legend, which allows the user to edit the legend box 
that is automatically created by some mapping operations; 

• menu item Redraw Window, which will completely redraw the map on the 
screen. 

• menu item Change View, which allows the user to directly specify the zoom 
level, the scale or the center position of a mapper; 

• menu item Previous View, which redisplays the mapper view that was in 
effect before the most recent change of view; 

• menu item View Entire Layer, which changes the active mapper's zoom 
level, scale and/or center position so that all the objects on a chosen layer (or 
on all layers) are visible on the screen; and 

• menu item Autolabel, which automatically labels (i.e., creates text 
information associated with) a random selection of the objects in a selected 
layer of the active mapper; 

• menu item Clear Labels, which erases from the screen any label information 
which may have been generated with the Label menu item or the Label Tool 
in the MapInfo tool palette. 

Each of these menu items will be discussed in turn. 

7.2 MAP 

The main purpose of the Map menu item is to create a mapper window. Normally the Setup 
Base Map and the Setup Data menus will result in the creation of a suitable mapper for the 
base map on the screen. If, however, this mapper is closed, the Map menu item can be used 
to create a new mapper. Some adjustment of layers and their properties may be necessary 
to recreate a previous mapper configuration; this can be done with the Layer Control menu 
item, described next. 

7.3 LA YER CONTROL 

The Layer Control menu item is a pass-through to the MapInfo menu item of the same 
name. When clicked on, the Layel' Control menu item displays a list of layers (tables) in 
the active mapper and allows a number of display characteristics for each layer to be 
individually controlled and cllstomized. (see Figure 23) A full description of the options 
provided by this menu item can be found in the MapInfo Reference. The following 
paragraphs simply summarize some of the possibilities. 
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Any individual layer of the active mapper can be removed from the mapper, and conversely, 
an open table can be added to the mapper as a new layer (of course, this only makes sense 
of the table relates to the same geographic area as the other layers in the mapper). 
Removing a layer from the mapper does not close the table or cause the information in it to 
be lost. 

Layer Control 
Zoom 

L.ayers Displa.l' Editable Selectable Layered 

Cosmetic La er Default 
SegTab 
PopTab 
BdyTab 

I ~ettings ... 

Default 
Default 
Default 

Reorder ------, 

x 
X 

U.p II .!?.OWf) "'--C-an-c-e-I -." OK 

Figure 23 

The order of layers in the mapper can be changed. The layers in the list displayed by the 
Layer Control menu item are drawn on the screen in bottom to top order. Any object in 
a layer that is higher in the list will be drawn over objects in layers that are lower in the list. 
Similarly, objects from different layers that overlay each other will be selected (with the 
Select Tool or the Info Tool, for example) in top to bottom order. Thus, by changing the 
order of layers in the mapper, the drawing and selection characteristics of the mapper can 
be changed. 

In addition, any layer can be made either selectable or not selectable through the Layer 
Control menu item. Objects in a non-selectable layer cannot be selected by clicking on them 
(although the Select menu item in the Analyze menu can still be used to select any item 
including those on non-selectable layers). 

If required, a layer can be displayed only if the zoom level is between user-specified 
minimum and maximum values. (This feature is not currently of much use in the RMS, but 
can be convenient in more general Maplnfo applications.) 

The means of labelling layer information is also specified through this menu item. Through 
the Label Settings subcommand, the user can specify the particular attribute (field) to be used 
for labelling, the type of line to be drawn between the label and the object being labelled 
(these lines are known as call outs), and the text style to be used in annotating the map. 

For further details on the capabilities and use of the Layer Control menu item, the Maplnfo 
documentation should be consulted. 
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7.4 THEMATIC MAP 

Clicking on the Thematic Map menu item displays a dialog box containing a scrollable list 
of currently-defined attributes(see Figure 24); these are the attributes used in the most recent 
dynamic segmentation operation. Each attribute in the RMS has a standard thematic 
presentation defined for it; for example, the standard thematic presentation of pavement width 
is with lines having different thicknesses corresponding to different ranges of pavement 
width. Clicking on one of the defined attributes and on the OK button causes a thematic map 
with the standard presentation of the selected attribute to be displayed on the screen; a 
standard legend is also displayed in a separate window. 

Thematic Mapping 

Attributes: 

OK I Customize Cancel 

Figure 24 

If several attributes are available (either because the feature selected for dynamic 
segmentation contains several attributes, or because the dynamic segmentation was done 
using a merged feature file), the Thematic Map menu item can be clicked on repeatedly to 
thematically present the data corresponding to each attribute. If the user selects the 
standardized presentation option for an attribute for which no standardized presentation has 
been defined, the RMS issues a warning. 

It may also happen that the user wishes to prepare a non-standard presentation of the 
available attribute data. Examples of non-standard presentations might include: 

• presentations which highlight one particular value or range of attribute values, 
and downplay all other values; for example, the user may want to highlight 
only road sections whose width is greater than 12 meters; 

• presentations based on an algebraic or logical expression involving several 
feature attributes; for example, the user may want to highlight only those road 
sections whose width is less than 6 meters and whose AADT is greater than 
30,000 vehicles/day. 

The Thematic Map menu item allows customized presentations through the Customize button 
in the dialog box. Clicking on this button gives access to the standard MapInfo Thematic 
Map menu item, which allows full user control over the values or ranges of interest, and the 
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symbols which will be used to display each of these. The MapInfo documentation describes 
the options in detail in Appendix 7 of the MapInfo Reference. 

7.5 REMOVE THEMATIC MAP 

As the menu item title implies, clicking the Remove Thematic Map item will removed the 
existing thematic map on the screen together with the legend window. This function is only 
available after performing the Thematic Map function. 

7.6 SHOW/HIDE MAP GRID 

This menu item shows the map grids in referenced to Zone 51 of the Universal Transverse 
Mercator(UTM) projection(see section 2.1). if they are not on the screen and removes them 
if they are present. The map grids are contained on a layer called MAPGRID which is 
added to the mapper or removed from the mapper based on the menu item that is available. 

If the Hide Map Grid menu item is clicked, the grid disappears and the menu item changes 
to read Show Map Grid. If the Show Map Grid menu item is then clicked, the grid 
reappears and the menu item changes to read Hide Map Grid. 

7.7 CUSTOMIZE LEGEND 

The Customize Legend menu item is a direct pass-through to the MapInfo menu item of the 
same name. It allows the user to customize the information displayed in a thematic map 
legend. The legend's title and subtitle, the annotation written for each value or range of 
values in the thematic map and the text style used for the display of each of these, can all 
be modified by the user(see Figure 25). 
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This Customize Legend menu item is probably of most use when the user decides to prepare 
a customized thematic map through use of the Customize button in the Thematic Map dialog 
box. 

7.8 REDRAW WINDOW 

The Redraw Window menu item is a direct pass-through to the MapInfo menu item of the 
same name, which allows the user to redraw the map on the screen. This is most useful when 
the generation of the drawing was interrupted by pressing the < ESCAPE> key. 

When click on this menu item, the system completely redraws the active window 

7.9 CHANGE VIEW 

Clicking on the Change View menu item gives access to the Change View dialog box which 
was discussed in section 3.4 above; this dialog box can also be accessed by clicking on the 
annotation in the bottom left-hand portion of a mapper window. It allows the zoom level, 
scale and center position of a mapper to be directly specified. 

7.10 PREVIOUS VIEW 

The Previous View menu item simply recalls the view on the screen before the most recent 
change of zoom level, scale or center position. The change in zoom level, scale or center 
position might have occurred as a result of the Change View menu item or through one of 
view-changing tools in the MapInfo tool palette (the Grabber, Zoom In or Zoom Out tools). 
It is not possible to recall views earlier than the most recent one. 

7.11 VIEW ENTIRE LAYER 

The View Entire Layer menu item adjusts the view in the mapper so that all graphic objects 
belonging to a user-specified layer (or to all layers) are visible. 

If there is only one layer in the active mapper, the View Entire Layer menu item adjusts the 
mapper's view without further user interaction. If there are several layers in the mapper, 
the menu item displays a dialog box which asks the user to select one of the available layers 
or all of them. Clicking on the appropriate choice and on the OK button then changes the 
mapper's view. 
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7.12 AUTOLABEL 

The Autolabel menu item is a pass-through to the Maplnfo menu item of the same name. 
Clicking on this menu item will cause labels to be written on the mapper for a user-specified 
layer. However, the user has no control over how many or which particular objects will be 
labelled; for example, if the user requests the PopTab layer to be labelled, there is no way 
to ensure that the provincial capital will be one of the objects that is labelled. Similarly, 
there is no way to control the placement of labels. The procedure is purely automatic. 

On the other hand, the user can control which field of the selected layer will provide the 
information written to the screen, and the text style with which the information will be 
written; this is done with the Layer Control menu item discussed above. 

7.13 CLEAR LABELS 

The Clear Labels menu item simply erases all labels or other temporary information which 
may have been written to the screen during an RMS session. After the user clicks on the 
menu item, the RMS asks the user to confirm the erasure by displaying the message "Discard 
all objects on the Cosmetic Layer?". The appropriate reply, if erasure is really wanted, is 
to click on the Discard button; clicking on the Cancel button will restore the screen without 
erasing anything. 
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CHAPTER 8 

THE LAYOUT MENU 

8.1 INTRODUCTION 

As explained in section 3.6, a layout is a type of window which allows detailed user control 
over the format and output presentation style of one or more mappers and/or browsers. 
Without layouts, users are only able to print or plot browsers or mappers just as they appear 
on the computer screen. With layouts, it becomes possible to prepare titles or title blocks, 
annotations, to arrange several types of window on a single sheet of paper, or to wallpaper 
a map or table (i.e., to print or plot it on several sheets of paper which are then fit together 
to make a larger-sized output). Layouts can also be used to predefine templates, which are 
general formats for presenting mapper or browser data; a particular mapper or browser is 
then included in the template and a final-form presentation can be made ready will minimum 
additional work. 

Pick Line 
Add T late 

Figure 26 

The RMS Layout menu is a direct pass-through to the MapInfo menu of the same name; all 
menu items are identical. The MapInfo Layout menu and its menu items are documented in 
the MapInfo Reference and in Chapter 10 of the User's Guide. 

Proficiency with layouts only comes with practice. Maplnfo layouts have a number of quirks 
which must be gotten used to. One of the less intuitive aspects of layouts is that the 
appearance of text on the screen does not usually resemble its appearance when it is output. 
For example, a particular text may appear not to be centered even though a command to 
center it was issued. Furthermore, the actual (i.e., printout) size of text in frames depends 
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on the zoom level of the underlying mapper window, whereas the actual size of text inserted 
directly into the layout window is invariant. 

Despite its peculiar appearance on the screen, if the appropriate formatting commands were 
correctly issued, text will appear as it should on the output. Again, it will take time and 
practice to become familiar with the use of layout windows and the Layout menu. 

8.2 SETUP LAYOUT 

Before opening a layout window with the Setup Layout menu item, users should make sure 
that the output device type and paper size specified with the File I Print Setup menu item (see 
section 4.4) are correct. All work done in the Layout menu implicitly refers to the paper 
size and output device type. If these are incorrectly specified, the results of outputting the 
layout are unpredictable. 

Once the correct output device type and paper size have been set, clicking on the Setup 
Layout menu item will open the New Layout Window dialog box. Option buttons provide 
for the creation of a single frame for the active mapper window (or any other particular open 
window), or of one frame for each of the open windows, or no frame at all; in the latter 
case, the Mapinfo Frame Tool from the tool palette can be used when required to define 
frames within the layout window. 

In any case, the actual shape of the mapper or browser image within a frame will be based 
on the shape of the mapper or browser window. By resizing these windows (see section 
3.3.2.3) the correspondence between frame and image sizes and shapes can be changed. 

8.3 DISPLA Y OPTIONS 

Clicking on the Display Options menu item opens the Layout Display Options dialog box. 
This dialog box was already discussed in section 3.6 above. Most of the preset options are 
unlikely to need changing by the user; the only display option that might usefully be changed 
by this menu item is the layout zoom level, expressed as a percentage of actual output size. 

8.4 LA YOUT SIZE 

Clicking on the Layout Size menu item opens the Layout Size dialog box. With this dialog 
box, the user can set the margins of the output page(s) and indicate if the output is to be 
wallpapered (the output will be spread over several sheets of paper and then fit together by 
hand) or directed to a single sheet of paper. 

8.5 VIEW ACTUAL SIZE 

The View Actual Size menu item adjusts the layout zoom level to 100% ; in other words, 
the image on the screen is (approximately) the same size as the image on the printout or plot. 
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(Computer screen adjustments and other factors make it difficult to guarantee that the screen 
image will be exactly the same size as the output image.) 

8.6 VIEW ENTIRE LAYOUT 

In a sense, the View Entire Layout menu item is the inverse of the View Actual Size menu 
item. It zooms to the level necessary to display the entire output (one or several pages) 
within the layout window on the screen. 

8.7 PREVIOUS VIEW 

The Layout I Previous View menu item is identical in function to the Map I Previous View 
menu item. It redraws the layout window as it was before the most recent change of zoom 
or position. Such changes might have been produced by the Display Options, View Actual 
Size or View Entire Layout menu items discussed in previous sections, or might have been 
produced using the Zoom In, Zoom Out, or Grabber tools from the Maplnfo tool palette. 

Only the most recent view can be restored; earlier views are lost and must be recreated 
through appropriate use of the positioning and sizing tools and menu items. 

8.8 BRING TO FRONT 

Because a layout window may contain various objects (frames, text annotations, graphic 
objects, etc.) and because these objects may overlap, the Layout menu provides a means of 
ensuring that one object overlays (and partially hides) another. This is the Bring to Front 
menu item. Clicking on an object with the Select tool then clicking on the Bring to Front 
menu item will ensure that the selected object is not wholly or partially covered in the output. 

8.9 SEND TO BACK 

The Send to Back menu item is the inverse of the Bring to Front menu item. Clicking on 
an object in the layout window, then clicking on the Send to Back menu item, will ensure 
that the object does not cover any other object on the output. 

8.10 ALIGN OBJECTS 

The Align Objects menu item is used to ensure that objects in the layout window are 
positioned correctly with respect to each other or to the output. Selected objects can be 
positioned so that their left edge, center or right edge are horizontally aligned with respect 
to each other or to the layout itself; similarly, selected objects' top edge, center or bottom 
edge can also be aligned with respect to each other or to the layout. Selected objects can 
also be evenly distributed with respect to each other in either the horizontal or the vertical 
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direction. 

8.11 CREATE DROPSHADOWS 

Finally, the Create Drop Shadows menu item draws drop shadows around selected items. 
Clicking the menu item opens a dialog box which allows the user to specify the horizontal 
and vertical distance separating the drop shadow from the selected item(s). Drop shadows 
can be used to enhance the presentation of selected layout objects. 

8.12 PICK FONT 

Pick Font menu item allows the user to choose a font for labelling or text. Choosing this 
menu item will give the user a dialog box that contains the font, font size and style feature 
The font can be pick by holding the mouse button down while dragging the cursor on the 
font the user wants, release the mouse button and the font selected. 

As the user perform the different operations in the dialog box the Sample Text window 
displays a sample of the type style. 

The user can use the Pick Font menu item together with the Select menu item of the Analyze 
menu to change the font on an existing text. 

8.13 PICK LINE 

Clicking the Pick Line menu item allows the user to set the default line style and change the 
line style object being edited. The dialog box displays the Line Palette, which allows the 
user to choose the color, width and style of the pen Mapinfo uses. As the user change the 
various attributes of the line style, a sample line is displayed in the left part of the dialog. 

8.14 ADD TEMPLATE 

A template is a standardized layout of a sheet of paper of a given size. It can includejrames 
in which the contents of on-screen windows will appear with a certain rectangular size and 
position, as well as independent text and symbols (title blocks, scales, etc.) in pre-positioned 
locations. The Add Template menu item allows predefined templates to be brought to the 
screen. It displays a dialog box with a list of defined MapInfo workspaces (which can 
contain, among other things, template definitions). By clicking on one of these and on the 
Open button, the corresponding template is brought to the screen. Double-clicking on a 
frame opens a dialog box which allows the frame to be assigned to one of the on-screen 
windows. (For this reason, templates should normally be added only after all required 
mappers and browsers are already open.) Double-clicking on independent items allows their 
contents or position to be changed. 
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CHAPTER 9 

THE HELP MENU 

9.1 INTRODUCTION 

The Help Menu is consists of two menu items 

• menu item Contents which allows the user to view the help file 

• menu item About Road Mapping System which shows the version of RMS 

9.2 CONTENTS 

The Contents menu item will open the RMS help file. Three buttons are provided which 
correspond to the operation listed below. 

CONTINUE button will allow the user to view the next screen of a given topic; 

QUIT HELP button will exit the help screen and return the control to the RMS; 

SEARCH button will provide a scrollable list box of topics based on the menu and 
menu items of the RMS. Double click on any of the desired topic will show the said 
topic on the screen. 

9.3 ABOUT ROAD MAPPING SYSTEM 

About Road Mapping System(RMS) displays a dialog box which shows which release of 
RMS Software currently running. 
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SYSTEM REQUIREMENTS : 

In order for RMS to run the following requirements are needed : 

HARDWARE : 

Any 80286,80386 or 80486 based microcomputer with at least 4 MBytes of 
RAM. 
Any monitor supported by Microsoft Windows. For best results, a VGA color 
monitor is recommended. 
A mouse supported by Microsoft Windows 
A Hard Disk Drive with 10 MBytes of disk space for program and feature 
files. Depending on the number of provinces to be installed (estimately 600 
Kbytes for each provinces), it will require additional disk space. 
a printer or plotter (optional) 

SOFTWARE: 

Microsoft Windows 3.0 or later installed on the hard disk and running on 
standard or enhanced mode 
MapInfo for Windows ver 2.1 or later installed on the hard disk 
RMS Installation Diskettes 

SOFTWARE PACKAGE: 

The software package is consist of the following : 

Installation disk (l High Density 3.5 inch diskette) ; 
Feature Files Data Disk (1 High Density 3.5 inch diskette) ; 
a USER, System Maintenance Guide and System Documentation; 
Spatial Files Data Disk ( High Density 3.5 inch diskettes); 
RMS Program Disk (High Density 3.5 inch diskette) 

INSTALLATION PROCEDURE: 

The System Requirements(both hardware and Software) have to be met in order to effectively 
run the RMS. 

Insert the RMS installation disk in drive B: .Invoke the installation procedure by typing: 

B: 
INSTALL 

The system will give a step by step procedures on how to use RMS Installation Software. 
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During the installation the following have to be entered : 

1. Windows Directory 
2. Maplnfo Directory 
3. RMS System Directory (the directory where to install RMS, the 

default directory is \RMS) 
4. RMS Feature Files Directory 
5. RMS Spatial File Directory 

The RMS install will then create the RMS, Feature Files and Spatial Files directory based 
on what was specified (If the directory did not exists). Copying of files is automatic. 

FEATURE FILES AND SPATIAL FILES : 

All Feature Files and Spatial files will be stored in the directories that were provided. 
Feature data files are supplied on a separate disk (Feature File Data Disk). Spatial Files are 
organized by province. Spatial file data diskettes (which are numbered) have subdirectories 
corresponding to individual provinces, with nothing in the diskette's root directories. 

In installing the Spatial Files, a menu will be provided that consist the list of provinces. The 
Enter key is used to Select/Unselect from the menu. 

Choosing the menu item ALL PROVINCES will require at least 30 MBytes of disk space 
from the hard disk, since it will install all available provinces spatial files. Another 
alternative is installing only those provinces that are needed. 

After pressing the ESC key, RMS will start installing the provinces that were selected. It will 
ask for the diskette/s that contain the province/s to be inserted and start copying the file 
to the Spatial File directory. It can be run again to install additional Spatial files if needed. 

The Spatial Files can also be copied to the Spatial Directory using the DOS Copy or XCopy 
Command. A file SFILES.LOC is provided which contains the list of province with 
their corresponding disk number and directories. 

RMS.INI: 

The RMS.INI is the configuration file of the RMS Software in the Mapinfo directory. It 
is the first file needed by the system in order to run. It contains the list of directories needed 
by the system. 

- Windows Directory 
- Mapinfo Directory 
- RMS System Directory 
- Feature File Directory 
- Spatial Files Directory 
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There are three ways to create or change the RMS. INI : 

by running the RMS Installation Software, the RMS. INI will be 
automatically created ; 
using the PREFERENCES menu item from the RMS Software (see Users' 
Manual); 
using a text editor. 

CONFIG.SYS : 

The number of files in the Config.Sys must be increased depending on the number of Spatial 
Files(Provinces) that will be opened. 

CREATING A RMS ICON: 

Creating the RMS icon (Program item) will have to be done under the windows 
environment. It is recommended to create the RMS program item under the MapInfo group. 

How to create a program item? 

1 
2 
3 

4 

5 

6 

Open the Mapinfo Group 
From the File menu in Program Manager, choose New. 
Select the Program Item option, and then choose the OK 
button, the program item properties dialog appears 
Type the following on the Program Properties Dialog Box 

Description : RMS 
Command Line : RMS.exe 
Working Directory : RMS Directory (ex C:\RMS) 
Shortcut Keys : None 

Choose the Change Icon button to see the RMS icon then 
choose the OK button. 
Choose the Ok button, the dialog boxes closes and the RMS 
Program Item appears on the MapInfo Group. 

RMS USER'S MANUAL: 

Tha RMS User's Manual is contained in the file USRDOC.RMS in RMS User 
Documentationl Diskette. You can print it using Wordperfect 5.1 
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RMS PROGRAM DISK: 

The RMS Program Disk contains the following files 

ADPTINS.LSP 
POPINS.LSP 
FEABLK.LSP 
IMPBDY.MBX 
IMPPOP.MBX 
IMPSEG.MBX 
IDENTl.MBX 
IDENT3.MBX 
UPDATAD.MBX 
UPDATEl.MBX 

HOW TO RUN RMS : 

RMS can only run under the windows environment 

1 from the Maplnfo Software, choose the USRPRO.MBX using the 
RUN menu item. (see Maplnfo Manual for more information) 

2 Clicking on the RMS Icon 
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APPENDIX B 
Modifying RMS Spatial and Feature Data 
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The RMS Software does not allow you to modify the Spatial and Features Data since the 
System Administrator and not the System User/Operator is assigned to do this task. The 
System Administrator should have an adequate knowledge of not only Maplnfo but also 
AutoCAD and ArcCaD in order to accomplished the task. 

Chapter 3, 4 and 5 of the System Maintenance Guide Documentation contains the step by 
step procedure to modify the Spatial Data and Feature Data. All the programs (AutoLISP and 
MapBasic) needed in the modifications of Spatial and Feature Data are provided in the RMS 
Program Disk which is included in the package. 

The System Documentation explains how the system works and will be a great help in 
providing information to the System Administrator. 
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